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Installing NetLogger

This section describes the basic setup of NetLogger for 3905 Century Club members.

Important: If you are currently running NetLogger 3.1.5 or older, be sure to
upgrade to the newest version of NetLogger, 3.1.7 before continuing. Certain
features described in this manual will not function as expected until you have
upgraded.

A. Configure and load NetLogger for the 3905 Century Club.

a. Ifyou have not yet done so, download NetLogger 3.1.7 or higher from
http://netlogger.org. Versions are available for Mac, Linux and Windows.
Follow their instructions to install.

b. Start NetLogger.

c. From the NetLogger Setup Menu select ‘Change Operator’. Make sure Call
Sign is your current call sign, and Name/Other is blank. Press ‘Done’ to
continue.

Set Operator
Call Sign AAOHF

Name / Other (optional)

Done

d. From the NetLogger Setup Menu select ‘Accounts’. You may optionally
configure your QRZ XML, eQSL and LoTW accounts if you have them.
Press ‘Done’ to continue.
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—QRZ XML Account Setup Y
QRZ Paid Subscription REQUIRED!

v Enable Online QRZ Callbook Lookups

Account | aaOhf ]
Password [ assssssase J
—eQSL Account Setup )

v| Use call sign for account name

Account [ AAOHF ]

Ask for password at upload/status time
Password [ sssssnes ]

\ 7 il

— LoTW Account Setup )
Use call sign for account name

Account [ ]

| Ask for password at status check time

Password [ ]

Done
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e. From the NetLogger Setup Menu select ‘Worked Stations Flag’. Select all
the boxes. Press ‘Done’ to continue.

— Worked Station Flag Y
Call Sign +

v Net

v Band

v Mode

v Club

v State

v M/P Status

Done

f.  From the NetLogger Setup Menu select ‘Club Profile and Callbook Order’.
Make sure the window is configured exactly like the following picture.
Press ‘Done’ to continue.

0@ Profile / Callbook Order
 Profile and CallBook Order 2
State CallBook, then Club Profile
Member Id Club Profile
Remarks Club Profile
QSL Info Club Profile, then Callbook
City CallBook, then Club Profile
Name Club Profile, then Callbook
County CallBook, then Club Profile
Grid Square CallBook, then Club Profile [}
Street CallBook, then Club Profile [}
Zip CallBook, then Club Profile [}
DXCC Callbook 2
Country CallBook, then Club Profile |5
Award Info Club Profile B
Preferred Name Club Profile, then Callbook B
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B. When it is time for a 3905 Century Club net, press the blue ‘Select Net’ button
and look for the 3905 Century Club net you would like to join. Highlight the net
name and press the ‘Monitor Net’ button to begin monitoring the net. Be sure to
check-in to the net over the air.

*** Your Installation of NetLogger is Complete ****
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Appendix |. Station Locations

The optional NetLogger ‘Station Locations’ feature is a handy way to make sure contacts you
log in NetLogger include key details about your station. This can include your operating
location, mobile/portable status, rig, power and notes to save with every log entry. The
feature is particularly helpful when operating mobile, with a club or special event, or from a
location related to a 3905 Century Club award.

NetLogger File View Edit - Function elogs Help

Club Profile ... |
Net Status an¢  Club Profile and CallBook Order ... :

To use Station Locations, select the
NetLogger ‘Setup’ menu and select

‘Station Locations’ -> Wci
Operator @
‘Net Activity ——y

: Station Locations
‘Chack-ine i

NetLogger Mo¢  Club Profile Update Fields ...
Club Nets ...

Default QSL Message ... ’
v Use Default QSL Message l

o0 e
(— Setup Station Locations
. . X Default
The Setup Station Locations menu will Home Combo with KKOHF and KEOGFT
. i . Home with KKOHF and NOL
appear and look something like this -> Mol FL Everglades NP
lobile
Mobile WI SC
Portable OH
TRIMN
TRIND
. . TRISD
The first time you access the setup
menu, you will see a location named
‘Default’. To configure your primary ,
. . — : -
location, click on the Default row to S ———
highlight and press ‘Edit’.
Copy and Edit New Delete Set Current

Done
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A Location popup will appear with the
station name ‘Default’ ->

As you see in the example on the right, fill
in your home station’s details.

When done, press ‘Save’. These details
will now be saved as part of each of your
logged contacts when your location is set

to ‘Default’.

It’s easy to add an operating location by
pressing ‘New’ in the Setup Station
Locations menu. Here you see another
location where I've enabled a club and
special event ->

Setting up your location this way tells
NetLogger to place three entries in your
Contacts list each time you log a single
contact from the location named ‘Home
with KK@HF and NOL'.

Version 7.6 — December, 2021
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00 Station Setup
— Station Info -
Station Name | Default |
LoTW Certificate -- none -- a
Station Call Sign
DXCC 291 - UNITED STATES OF AMERICA B
State MN - Minnesota a
County Anoka a
ITU Zone 7 €Q Zone |4
Grid Square | EH35hi | otap [ ]
City | J
Country | |
M/P  Fixed E TX Power
Rig Info | IC-7600 ]
Station Notes  Fixed at Home
Enable Club Enable Additonal
ClbCallSign [ | AdditonalCaliSign [ |
Club M/P  Fixed S Additional M/P  Fixed <
[ JON ) Station Setup
(— Station Info
Station Name | Home with KKOHF and NOL |
LoTW Certificate -- none -- B
Station Call Sign @
DXCC 291 - UNITED STATES OF AMERICA a
State MN - Minnesota a
County |Anoka |
ITU Zone 7 [~ | CQZone 4 [~ |
Grid Square | EN3shi | otap [ |
City [ l
Country [ ]
M/P | Fixed TX Power
Rig Info | IC-7600 ]
Station Notes | Fixed at Home
Enable Club Enable Additonal )
Club Call Sign Additional Call Sign [NOL |
Club M/P | Fixed B Additional M/P | Fixed e ')

Save
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When you join a net, select your station location by using the drop down in upper right of
the ‘Contacts’ section as shown below. This example shows how to log contacts using the
new location created above. Three log entries are created when you log a single contact!
Note the log entry ‘Station’ field holds the callsigns configured as primary, club and special
event.

Note: You can control with fields are visible in your Contacts window using the NetLogger
‘Edit’ -> ‘Contacts Table’ -> ‘Enable/Disable Columns’ menu.

UTC Net Status and Control :
i NetLogger Mode | STANDALONE Net 3905 75m Early Net v | Profile | 3905CCN Ti
Operator | WOABC Frequency Mode SSB v Band [75m |~ NCS | WOABC Logger
Net Activity [r Ir Ir Ir
e | T T BT (B
= .
—Check-ins — -
# CalSgn MP State gz: :S; Status  Ppetered Remarks Avard // ?j'f' Name City Country  DXCC
oG Ton 5 s W Den  RCCCWMMNOME  GR  DenwOms |
: i Set your station location
7 hers J
-_—8 /
3= : !
- g g g g g ¢ Call Sign Filter Remarks Filter Operator Filter Current Station Location 0
ﬂd!ﬁﬂﬂﬂ L 4 Net Filter Megber d Fier | Custom Fiter | Home with KKOHF and NoL._~ E
# CalSgn MP State Date ({r'r“g; asT PST Froquency Operator[ Station| ¥ MY Mode Band ::;; Power Station asL Name
3 N7XG OR 2021/10/25 01:27:36 57 |59 3,902 WOABC | NOL MN ss8 75m | IC-7600 1000 | Fixed at Home aB Dean W. Davis
2 N7XG OR 2021/10/25 01:27:36 57 |59 3,902 WOABC | KKOHF MN SS8 75m | IC-7600 1000 | Fixed at Home aiB Dean W. Davis
1 N7XG OR 2021/10/25 01:27:36 57 59 3,002 WOABC HF MN sSB 75m | IC-7600 1000 | Fixed at Home aB Dean W. Davis

Station Locations is particularly helpful when you operate from a location like a Tri-Point
where there is a need to record multiple log entries for each contact.

(Setup Station Location:
Defauft
Home Combo with KKOHF and KEOCFT

Home with KKOHF and NOL
To log contacts for all three states at Hobie L Evoldes NP
Mobile WI SC

a Tri-Point, create one station Poratie O

location for each state at the Tri-
Point, highlight all three in the Setup
Station Locations menu, and press

‘Set Current’ ->

Edit Copy and Edit New Delete

Done
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The 3905 Century Club

With your current station location set this way, a single press of the ‘Log Contact’ button
will create all the correct log entries for the Tri-Point QSO as shown in the example below:

Station Locations is a flexible feature allowing to log contacts in NetLogger with key details

about your station.

Version 7.6 — December, 2021

~Ci
- g - g g G Call Sign Filter Remarks Filter Operator Filter Current Station Location 5
ﬂguggd 7 'g Net Filter Member Id Filter ' Custom Filter -- Multiple Stations -- m
: RST RST My My Station asL
# CallSign MP State PA R Frequency Operator WP Band Riy Power o Name
9 N7XG OR 57 |50 [3002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
8 N7XG OR 02:02:19 | [57 [59 [ 3,002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
7 N7XG OR 02:02:19 | |57 [50 [ 3,002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
6 N7XG OR 02:02:19 | |57 |59 | 3,002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
5 N7XG OR 02:02:19 | |57 |50 | 3002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
4 N7XG OR 02:02:19 | |57 |50 | 3.002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
3 N7XG OR 02:02:19 | |57 [59 | 3,002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
2 N7XG OR 02:02:19 | |57 [59 [3,002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis
1 N7XG OR 0202:19/ |57 [59 | 3,002 WOABC M 75m | TS-480HX | 200 | MN-SD-ND Tri-Point aB Dean W. Davis




3905 Members Guide to NetLogger The 3905 Century Club

Appendix II. Transferring Files from the N7XG Logger to NetLogger

This optional section describes the steps necessary to copy your basic contact data
from the N7XG logger to NetLogger.

A. Ifyou are currently using NetLogger for any other nets, be sure to save your
existing NetLogger logged contacts before continuing. You may use the
NetLogger File->Export->To ADIF File menu item to save existing contacts.

B. Start the N7XG Logger. Create a CSV (comma separated) text file containing your
logged contact data stored in the N7XG logger. Perform the following steps:

a. To begin, open the N7XG logger and select ‘Export Contact Data’ from the
File menu.

Open Checkins £) % @ B e g @\ Q W @ ’
Save Checkins E — - o

- . requency: DX: uick Finy ontacts Order
Print Checkins X

I I Sch Start: Callsign <

System Options |M... [QRP [YL |Remarks st [Name [Status [Sent [Rec |Rind1 [Rnd2 [Fnd3 [Rnd4 |

Merge Log Files

Import From CC Remote

Download Updates

Import Log Data 3
Import Options »
Export Contact Data

ADIF Export

Restructure on Next Startup

Close
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b. Step 1: You will see the Export Wizard window. Select ‘Text file (*.txt)’".
Press ‘Next’ to continue.

Export Wizard | S|
Step 10f9
This wizard allows you to specify details of how to export your data. Which
export format would you like?
[ Table type
" Paradox file [*.db) " QuattroPro file (*.wql)
" DBase file [*.dbf] " SOL script file (*.sql)
(& Text file [*.txt) " XML file [* xml)
¢ HTML file [*htm]) " MS Access database [*.mdb)
(" Excel spreadsheet [*.xls) " MS Windows clipboard
" Excel file [* ls) " Rich Text format (*.rtf)
 ‘Word file (*.doc) " SPSS format [*.sav)
¢ SYLK (Symbolic Link) [*.slk) " Adobe Acrobat Document [*.pdf)
¢~ DIF [Data Interchange Format) (*.dif) ¢ LDAP DatalnterchangeFormat [*.Idif)
" Lotus 1-2-3 file (*.wk1) ¢ ADO connection
Specifications... | I Back | Nest > | > | Cancel |

= — — = — y

c. Step 2: You will see the Step 2 Export Wizard window. Choose File Origin
of ‘ANSI (Windows)’, and check the ‘Include column titles’ and ‘export the
original value types’ boxes. Press ‘Next’ to continue:

Export Wizard w23 |
Step 2 of 9

Specify custom options for data exporting

File Origin: [ANSI (windows] |

[” Selected records only

$

[~ Blank if zero

[V export the original value types

Specifications... I << < Back | Nest > | > | Cancel
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The 3905 Century Club

d. Step 3: You will see the Step 3 Export Wizard window. Check ‘Delimited
option’. Select ‘Comma’ as field delimiter, ‘CRLF” as Record separator and

e.

“(double quotes) as Text qualifier. Press ‘Next’ to continue.

Export Wizard
Step 3 0f 9

Select the appropriate delimiter to separate your fields.

(¢ Delimited - Characters such as commas or tabs separate each field
" Fixed Width - Fields are aligned in columns with spaces between each field

— Field delimiter

PR
o ?228 Record separatorzl CRLF vl
" Semicolon Text qualifier:l" vl

" Other symbol: I
Specifications... | <<| < Back | Next > I>>| Cancel

Step 4: You will see the Step 4 Export Wizard window. Generally, there

should be no changes required on this window. Compare your screen to
the following picture and make sure they match. Press ‘Next’ to continue.

Export Wizard X
Step 4 0f9

You can define any custom data formats.

— Dates, Times and Numbers

Date Order: I MDY v I Decimal Symbol: I
Date Delimiter: I/ Thousand Separator: I
Time Delimiter: I: Currency Symbol: |$

v Four Digit Years

[~ Leading Zeros in Dates Logical values: ITrue |False

Cancel |

5 — = — . —

Version 7.6 — December, 2021
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f. Step 5: You will see the Step 5 Export Wizard window. Carefully select

The 3905 Century Club

ALL the exported columns in the scrolling box on the left. Start with
Callsign and scroll down to QSLInfo. ALL FIELDS MUST BE SELECTED

FOR EXPORT.

Note: Exported columns must appear in the following order only.
If they are not, drag and drop them to the correct positions:

Callsign
Mobile
State

Date

Time

Band
Frequency
Mode
His_RST
My_RST
Sent

Rec

Name

City
Remarks
NetName
StateCap
MasterHolder
YL

Myrcall
OpState
OpMode
OpLocation
QSLInfo

Go back and confirm the field names are in the above order and
that every box on the list is checked. Confirm the Title and Data
sections match the following picture. Press ‘Next’ to continue.

-— 1
Export Wizard (oS
Step 50f9
‘You can define custom properties for the exported columns.
Title
v OSL_Rec : Rec . -
V! Name Caption: ICaIIS|gn
! City Al e -
V! Remarks lignment: II_N _]
V! NetName i -
V| StateCap Background: || :|_J
! MasterHolder 7
VYL
V! Mycall a3 Data
V! OpState 3 ) T -
v Ophode Alignment: ||,:n _l
V! OplLocation ! -
! @5LInfo - Background: [ ~|
Font: |MS Sans Serif, 8 —I
Specifications... | <<| < Back | Cancel |

Version 7.6 — December, 2021
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g. Step 6: You will see the Step 6 Export Wizard window. Leave the Header
and Footer fields blank. Press ‘Next’ to continue.

Export Wizard ]
Step 6 of 9

You can add a custom header and/or footer.

Header

Footer

> | Cancel

Specifications... | << < Back

h. Stef) 8: You will see the Step 8 Export Wizard window. (There is no step
7). No changes should be required on this window. Confirm your screen
matches the following picture. Press ‘Next' to continue.

v Export Wizard X |
Step 8 of 9

v

You can select desired layout of exported data

—Preview
I
Layout
" columnar
€ reversed columnar

" tabular form

Color Style:

I MNarmal LI

g > | Cancel
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i. Step 9: You will see the Step 9 Export Wizard window. In the ‘Export to a
File’ field, enter a file location and name on your PC to store the exported
log. We suggest saving the log file on your Desktop so you can find it later
from NetLogger. You must change the last three letters of the file name
from txt to CSV. Confirm the rest of the window matches the following
picture. Press ‘Execute’ to continue.

Export Wizard g

Step 9 of 9
That's all of the information the wizard needs to export your data.
-
Lt ~
N
Q Export to a File:
&'\% |C:\U sers\MyNamehD esktop\MyCallSign.CSV _I

...i‘./:{ ’/’

[ Merge ex file

™ Records per each file I

Action after exporting
¢ None

" open for file view
" e-mail with file attachment

Specifications... | << | < Back | | Execute

j. Your contacts will be exported. Confirm your file was created on the
Desktop and has a size greater than zero.

. P Search Results in Desktop » . —

Organize v Save search Bum £~ 0 O
W Favorites MyCaIISign,CSV Date modified: 1/10/2016 10:33 AM
Bl Desktop Size: 680 KB
& Downloads
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C. Loading your N7XG Contacts into NetLogger

a. Start NetLogger. From the file menu select ‘File’, then ‘Import Contacts’,
then ‘From CSV File’.
@ NetLogger m View Edit Setup Function Help

ﬁ
[:Net Activity:]

Check-ins
Member QsL

# Call Sign State Id A Remarks e

Open Check-in File ... ! NetLogger !
Save Check-ins
Save Check-ins As ...

\E Net

> From CSV File ...
I From ADIF File ...

New Net Window

Mot

Import Contacts

1
2

b. Navigate to the Desktop and select the N7XG CSV file you created in
Section B. Press ‘Open’ to continue.

Your N7XG log file should be imported and visible in the lower Contacts
section of the screen. When your contacts are imported, the ‘Send Conf
By’ and ‘Rcvd Conf By’ fields are mapped to NetLogger as follows:

‘Sent Conf By’ Definition N7XG NetLogger

Send a card direct D d
Send a card via bureau N n
Card mailed S C
No card needed X N

‘Revd Conf By’ Definition N7XG NetLogger

Waiting for card N n
Card received R C
No card expected X X
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Appendix lll. Exporting Contacts in ADIF Format

Sometimes you may wish to share or archive the logged contacts stored in
NetLogger. You can accomplish this by exporting your contacts to a file, then
attaching that file to an e-mail or use another method to transfer that file to your
intended recipient. The preferred file format for your contact export is ADIF.

You may choose to export all, or some of your contacts from NetLogger.

A. To export all your contacts to a file in ADIF format, choose the ‘File’ then
‘Export’, “To ADIF File’ and ‘All Contacts’ menu items as seen below:

NetLogger m View Edit Setup Function elLogs Help

[ ] Open Check-inFile ... | NetLogger 3.1.7 - STANDALONE
Save Check-ins
i Save Check-ins As ... IE: Net Prof
New Net Window .
Frequency :] Mode SsB [ Band 40m [ NCS

Import Contacts >

ctivity
=

k-ins

All Contacts ...

B. To export only a selected set of contacts to a file in ADIF format, first
highlight the contacts you would like to export in the ‘Contacts’ window as

seen below:

—Contacts ,

1 g I I g I Call Sign Filter ~ Remarks Filter Operator Filter Current Station Location g

duugugi _A Net Filter Member Id Filter  Custom Filter Default E
# CallSign MP State Date v ar;r"gg gfn ST Froquency Operator  Station s‘":{e iy Mode Band ,’;z Power o

10784 WYBN CA 2021/08/26 041623 22 |2 7192 AADHF AADHF OH |M 40m T!’MBOHX EM ComboAAOHF/KEOCF

8 Q2 2 0o
2021/0&/26 [04:08:47 [55 | A M 888 40m

| 2021/08/726 | 04:08:47 7102 | AAOHF | KKOHF OH ss8
2021/08/26 | 04:08:45 7492 | AAOHF | AAOHF | OH |'ss8
2021/08/26 04:08:45 m 7.102 AADHF KKUHF OH ssa 40m

WEAHCR N B 4z s Bo A
10777 WF4ROG NC 2021/08/26 040709 44 |44 7.192 AADHF | KKOHF OH M 958 40m TS-480HX 2(!) ComboAAOHF/KEOCF

Once you have highlighted the contacts you wish to export, select the ‘File’
then ‘Export’, “To ADIF File’ and ‘Selected Contacts’ menu items as seen
below:

NetLogger Iia View Edit Setup Function elLogs Help
Open Check-in File ...

Save Check-ins NetLogger 3.1.7 - STANDALONE
Save Check-ins As ...

New Net Window

Import Contacts Frequency :] Mode SSB Band 40m
m’l’n-ﬂﬂ-!-‘_(-'m;mrv-
Selected Contacts ...
All Contacts ...

To ADIF File >

|

~Chark-ine

You will then be prompted for a file name in which to save your selected contacts.
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